
Accucadd is a 32 bit Windows program in which each function has a name. These names are grouped under

twelve headings to form the Main Menu, which is displayed across the top of the screen while you are using

Accucadd. Each heading produces a submenu when selected, as explained under Accucadd: Operation.

Function, icon, and sub-function names are usually written thus:

� “Draw: Elements” means the Elements function in the Draw

menu.

� “Dimension: Distance: Vertical” means the Vertical icon in the

Dimension: Distance function palette.

Keyboard shortcuts (Hot Keys): The characters shown in the main column below are the “short cut” or

“hot keys” for Accucadd. For example, to use Edit: Wipe simply press

the w key on the keyboard. Note that all the shortcut keys are lower

case - don’t press Shift, and ensure Caps Lock is Off.

Keys Function

a Toolkit: Angle Trap

b File: Backup: Backup Now

c Draw: Copy

d Edit: Erase (Delete)

e Draw: Elements

f Library: File and File: Save

g Toolkit: Grid

h Draw: Hatch

i Library: Import RDF

l Library: Load and File: Open

(lower case letter L, not number 1 or letter I)

m Edit: Move

n Toolkit: N-Tan Trap

o Toolkit: Orth Trap

p View: Previous View

r View: Redraw

s Library: Export (Save) RDF

t Draw: Text

u Edit: Undo

v File: Viewprint

w Edit: Wipe

x Toolkit: X-Y Coordinate

z View: Zoom (see below)

Zoom - a special case Accucadd provides a special quick access to zoom, typically the most

frequently used function. Simply place the cursor at the point on the

screen that you wish to be the center of your zoomed view, and press

the plus ( + ) key on the numeric keypad—typically over at the ex-

treme right of the keyboard. Similarly, you can Shrink the view by using

the minus ( - ) key on the numeric keypad.

Pan If you are in a zoomed view, pan can be accessed through the regular

Windows Scroll Bars .
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Intellimouse Zoom and Pan If you have a Wheelmouse and Intellimouse driver, or equivalent, you

can zoom and pan by using the mouse wheel. Some three button mice

have some of this functionality. Exactly what is available depends on

both the hardware and the driver that you are using.

Keyboard selection: If you wish to use the Accucadd keyboard selection feature the char-

acters to type for each function are shown below. In general, use the

Alt key when typing the letters. Use the Esc key to “put away” a

menu you don’t need. Note that some sequences are “hot” - they work

as soon as you type the letter(s) - while other sequences require you

to press the Enter key.

System Menu (Accucadd Icon) The System menu contains standard Windows functions only.

Consult your Windows documentation and Help files for more in-

formation on this menu.

File Menu The File menu contains functions used to start, save, print, and

close your drawing.

New Page Start a new drawing page.

A maximum of two (and the Scratchpad) may be in use at once.

Open... l Show the library to open (load) an existing drawing.

The same as Library: Load

Save... f Show the library to save (file) your current drawing.

The same as Library: File

Close Page Close the current drawing page. If there is a drawing on it you will be

asked to save it.

Backup b Set up and work with backups of your drawing made by

Accucadd’s automatic backup system. Note that this is an equipment

failure backup only. It only backs up the drawing you are currently

working on—it is neither a substitute nor a replacement for your own

security backup of your drawings.

Print Output the current drawing on a printer connected to your computer

(or network). In general the printer should be capable of using the

same paper size as you are drawing on. Also permits a color test print.

Viewprint v Output the current drawing on a printer connected to your com-

puter (or network). The paper size and scaling are disregarded. The

drawing is resized (by an unknown amount) to fit onto the currently se-

lected printer and paper size. Also permits a color test print.
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Print Setup... Select the current printer and set its properties.

Exit Shut down Accucadd. If there are any drawings open, you will be

asked to save them.

Special case If you have previously copied (embedded) an Accucadd drawing to

another application (using Clipboard: Drawing Data), you can dou-

ble click the Accucadd drawing in that application, and

automatically open Accucadd with that drawing ready loaded for

editing.

If you do this, you will see two other menu items in the File

menu:

� Update... Click this to Update the Accucadd picture in the tar-

get application (in this case, Microsoft Word), and leave

Accucadd running.

� Exit... Click this to close Accucadd, and return to the target

application. If you do not first click “Update...” your changes

will be lost.

If Accucadd was already running, the embedded drawing will be

on a new drawing page–it will not affect drawings already on

pages 1, 2 or the Scratchpad.
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Clipboard The Clipboard menu contains two functions used to copy

Accucadd drawings into other Windows applications. For exam-

ple, you can copy an Accucadd drawing, and paste it into a

Microsoft Word document. In general, the true world size and

scale of the Accucadd drawing will be lost, but the relative pro-

portions will be maintained.

The underlying format of the drawing is a Windows Meta File (WMF)

which retains the vector properties of the original drawing. This means

that it can be re-sized without losing resolution.

To Paste the Accucadd drawing into the target use the target’s Edit:

Paste menu or Ctrl-V.

Metafile Copies only the entities in the drawing. The copied data will occupy the

smallest rectangle that can be drawn around and enclose the drawn

lines, arcs, etc..The drawing is a metafile, and can be edited by the tar-

get application (if it has a graphics editor–for example, Microsoft Word

Picture Editor).

Drawing Data Copies the entire drawing, including blank space. The copied data will

include the blank space surrounding the drawn lines, arcs, etc. out to

the paper edge. The drawing is inserted into the target application

(e.g. Word) as a Windows “Object” (of type “Accucadd Drawing”). This

means that if you double-click the drawing (in Word), Accucadd will

automatically start up “inside” Word, allowing you to edit the drawing.

Technical note Clipboard: Drawing Data is the starting point for using Accucadd in a

Windows OLE/DDE client/server relationship. The requisite registry

entries are made when Accucadd is run for the first time. Accucadd

impements OLE through the MFC class library.
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Set Up The Set Up menu contains functions used to control your

Accucadd working environment, and to control some parts of the

drawing environment. Basic facts about the drawing (e.g., scale,

paper size, drawing units) are set up here. Setting the Layer Table

is the most important function here, and should be understood

before serious use is made of Accucadd.

Paper Alt(s) Enter Select or define required paper size

Scale Alt(ss) Enter Define scale of drawing

Units Alt(su) Select units to be used for measurements

Precision Alt(sp) Enter Set dimensioning precision

Layer Table Alt(sl) Create and alter Layers and the layer table

(Note: lower case letter ‘L,’ not number 1 or letter I)

Snaps Alt(sss) Enter Set snap Trap Zone,

control saving and loading of snap list

Colors Alt(sc) Select current drawing color

Set Digitizer Alt(ssss) Enter Define the digitizer scaling
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Draw Accucadd drawings are made up of Entities, as described under

Accucadd: Orientation. The Draw menu functions are used to

create these Entities; some of them (e.g., Parallel, Polygon) are

special techniques for drawing several Entities at a time. The

types of Entities are described under Summary: Entities.

Elements e Draw basic elements

Drag Insert Alt(dd) Add Inserts, with simple transformations

Frame Insert Alt(df) Enter Add Inserts, with complex transformations

Hatch h Fill regions with patterns

Curve Alt(dc) Enter Draw a variety of curve types through points

Text t Add text to the drawing

Tan Circle Alt(dtt) Enter Draw a circle tangent to lines and/or points

Polygon Alt(dp) Enter Draw regular polygons

Fillet Alt(dp) Enter Draw a fillet arc between two Entities (or points)

Chamfer Alt(dcc) Enter Chamfer a corner between two Entities

Parallel Alt(dpp) Enter Create parallels and concentric circles

Balloon Text Alt(db) Create automatic boxes around text

Copy c Copy part (or all) of a drawing

Stretch-Copy Alt(ds) Enter Copy, stretching joining lines
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Edit The Edit menu functions are used to alter the Entities that make

up Accucadd drawings.

Undo u Undo the last drawing action

Redo Alt(er) Undo the last undo

Erase d Select then delete Entities or groups of Entities

Change Alt(ec) Enter Select then change line styles, line weights, colors or

layers

Move m Select then move an insert, element or group of

Entities

Stretch Move Alt(es) Enter Select then move and stretch lines connected to the

move

Cleanup Alt(ecc) Enter Trim or tidy elements, or corners

Erase Points Alt(eee) Enter Delete unwanted Points

Text Alt(et) Change or duplicate text

Layer Alt(el) Edit the layers in a drawing

(Note: Lower case L, not number 1 or letter I)

Isolate Alt(ei) Enter Select an insert for alteration

Explode Alt(eeee) Enter

Convert an insert into a collection of separate Entities

Implode Alt(eii) Enter Convert a set of Entities into an Insert

Add Snap Alt(ea) Create or add to the `magnetic’ snap list

Wipe w Discard the drawing.

Note: you can not undo a Wipe!

Sort Alt(ess) Enter Select then sort Entities or groups of Entities
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View The View functions are used to select an area of the drawing for

viewing. The Speed Filter function allows types of Entities to be

hidden selectively.

Redraw r Redraw the drawing at `base view’

Regenerate Alt(vr) Enter Rebuild the Display List for the current view

Pan Alt(vp) Enter Inspect areas adjacent to a zoom view

Zoom z Magnify part of the drawing

Shrink Alt(vs) Enter Shrink the current view

Previous View p Return to the view

Save Zoom Alt(vss) Enter Save the current zoom view

Load Zoom Alt(vl) Display a saved zoom view

Note: lower case L, not number 1 or letter I

Speed Filter Alt(vsss) Enter

Filter out classes of Entities for speed of redrawing1

Options Alt(vo) Control redrawing and regeneration

Note: lower case letter O, not zero.
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3-8 Reference Manual Accucadd

1 This is only provided for compatibility with revious versions (RoboCAD) and is not needed on current

computers. We do not recommend using it as the results can be confusing.



Library The Library functions work with Accucadd visual drawing librar-

ies and their Index Pages, and also with the “RDF” files which are

used for archiving drawings and moving drawings between pro-

grams. Accucadd libraries are explained under “The Library” in

Accucadd: Orientation.

The “DXF” files used by many other systems can be translated and

used by Accucadd with the Import DXF and Export DXF menu items.

HPGL (Hewlett-Packard Graphics Language) is a format produced by

many business packages for line graphics. It is also produced by

“printing” to file using a Hewlett-Packard simple pen plotter driver, like

the HP7475.

Note throughout this section that the character “l” is a lower case L, not

the number 1 or the upper case letter I (for India).

File f Save a drawing on a library index

Load l Retrieve a drawing from a library index

Maintenance Alt(lm) Copy and Delete indexes

Add Index Alt(la) Add an index to an existing library

Set Pathname Alt(ls) Define and select pathnames for libraries and files

Import RDF i Convert and load an RDF file

Export RDF s Save the drawing as an RDF file

Group Export Alt(lg) Export part of the drawing as an RDF file

Import DXF Alt(lii) Enter Convert and load a DXF file

Export DXF Alt(lee) Enter Save the drawing as a DXF file

HPGL Import Alt(lh) Convert and load an HPGL file

Log Maintenance Alt(lll) Enter Delete and Edit Accucadd Library Log files
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Toolkit The Toolkit functions provide drawing “tools”, including analo-

gies to set-squares, protractors and the like.

The “snapping” concept, used to provide most of the drawing

tools, is explained under “Snap Points, Grids and Traps” in

Accucadd: Orientation.

Points Alt(tp) Add/display/disable/enable snap points, midpoints,

and intersections

Angle Trap a Set traps at any angle

Grid g Set a rectangular grid

Radial Grid Alt(tr) Set a circular grid

Orth Trap o Set orthogonal traps

N-tan Trap n Set normal-and-tangent traps

X-Y Coord x Display the cursor’s position

Arc Direction Alt(taa) Enter Set the current direction tangential to an arc

Line Direction Alt(tl) Set the current direction along a line

Note: the character “l” is a lower case L, not the

number 1 or the letter I

Tangent Alt(tt) Find & draw tangents between a point and a circle or

between two circles

Find Layer Alt(tf) Select Entities, and get a readout of which layers

they are drawn on, and also their other properties.
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Dimension The Dimension functions use special Dimension Entities, which

are explained under Dimension: Entities (q.v.). Dimensioning

conventions are set up by means of dimensioning Styles, the

most complex and important of the various Styles used by

Accucadd.

Set up Alt(is) Set up the dimension style

Edit Dimension Alt(ie) Change dimension position or style

Line Alt(il) Dimension between two points

Radius Alt(ir) Dimension the radius of arcs

Diameter Alt(id) Dimension the diameter of circles

Angle Alt(ia) Enter Dimension an angle

Arrow Alt(iaa) Enter Place arrow heads on lines, circles and arcs

Area Alt(iaaa) Enter

Calculate and display the Area and Perimeter of

a selected part of the drawing
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Window The Window functions are the standard Windows controls for ar-

ranging the components of a window and controlling their

display. For details on Windows menu items consult your Win-

dows Help system.

Toolbar Alt(wt) Show or hide the Toolbar

Status Bar Alt(ws) Show or hide the Status Bar

Cascade Alt(wc) Arrange the windows one in front of the other with a

small offset

Tile Horizontally Alt(wh) Arrange the windows one above the other

Arrange Icons Alt(wa) Arrange icons (minimized drawing windows) at the

bottom of the Accucadd window.

1 Page 1 Alt(w1) Make Page 1 active2

Note: the figure 1

2 Page 2 Alt(w2) Make Page 2 active

3 Scratchpad Alt(w3) Make the Scratchpad Page active

Special case Entering Accucadd from another application (DDE or OLE). See the

“File” and “Clipboard” menu sections for more information.

3 Accucadd Drawing in

Document 1

Alt(w3) Make the embedded drawing active. This only hap-

pens if you have previously inserted an Accucadd

drawing into another application (using Clipboard:

Drawing Data to copy it from Accucadd, and then the

other application’s Edit: Paste or Ctrl-V command).

The number at the beginning may not be 3–it de-

pends on whether any other Accucadd windows

were open when the embedded drawing was acti-

vated.
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Help The Accucadd system information and Windows based Help

functions.

Environment Alt(he) Show the Accucadd version and computer operating

conditions

Help Contents Alt(hh) Bring up the Accucadd on-line help system. This

uses the standard Windows “Help” system, and for

information on how to use it you should check your

Windows documentation.
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The Accucadd Family has many customization facilities. This section provides a list.

Drawing environment The Accucadd drawing program has a variety of customization func-

tions:

� Inserting drawings of standard components can reduce complex

projects to a simple assembly task. Draw: Drag Insert gives de-

tails.

� All the menu and palette settings can be saved by Save Setup

to establish a default working environment.

� Style files can save a choice of standard setups for:

Text styles (Draw: Text)

Parallel line drawing (Draw: Parallel)

Dimensioning (Dimension: Set Up)

� Incremental labeling can be applied in any sequence desired.

Like attributes, labels can be created as standard sets and ap-

plied to many drawings.

� Custom Layer Tables (SET UP: LAYER TABLE)can be created

for drawing projects, and can be saved in the libraries that use

them.

� Accucadd automatically saves your current Layer Table, paper

sizes (Set Up: Paper Size) and the directories that you load and

save data from (Library: Set Pathname), adjusting itself to your

work.

� View: Speed Filter allows you to customize the display of your

drawing for faster working.

� File: Print and File: Print Setup allow you to change printers eas-

ily from within Accucadd.

� Dimensioning symbols and tolerance text can be customized to

your own standards, following the instructions given under Di-

mension: Terminators.

� Text fonts can be created and altered using RoboFONT, and

added to other copies of Accucadd.

� Customized library logging and tracking facilities can be created

using Accucadd’s built-in library log system.

CUSTOMIZATION SUMMARY
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Most drawing work with Accucadd is done by positioning the cursor at points in the drawing. This section sum-

marizes the techniques for doing this.

� Free Positioning

This uses the Mouse to position points by eye on the screen

without any drawing aids. It is quick, but inaccurate.

� Point Snap

This uses the `magnetic’ attraction of snap points, automatically

created at the endpoints of Entities, to position the cursor at

these endpoints. See Toolkit: Points.

� Grid Snap

This uses the Grid tools to provide a regular set of `magnetic’

points which attract the cursor. See Toolkit: Snap Grid.

� Value Entry

This is used for entering Elements at precise sizes (angles and

lengths), by typing them on the keyboard. It and the techniques

described below are described under Draw: Keyboard Input.

� X coordinate from Datum

This is entered by using the F1 key, to set an X coordinate for

the cursor while leaving it free to move along the Y axis. The co-

ordinate is measured from the last Datum Handle placed in the

drawing. Also accessible from Toolkit: X-Y Coord.

� Y coordinate from Datum

This is entered by using the F2 key, to set an Y coordinate for

the cursor while leaving it free to move along the X axis. The co-

ordinate is measured from the last Datum Handle placed in the

drawing. Also accessible from Toolkit: X-Y Coord.

� X, Y coordinate pairs from Datum

These coordinates are entered using the F5 key and are mea-

sured from the last Datum Handle placed in the drawing.

� X, Y relative coordinate pairs

These coordinates are entered using the F6 key. They are mea-

sured from the previous point entered in the drawing.

� Radius and Angle coordinate pairs from Datum

These coordinates are entered using the F7 key and are mea-

sured from the last Datum Handle placed in the drawing.

� Radius and Angle relative coordinate pairs

These are entered using the F8 key. The coordinates are mea-

sured from the previous point entered in the drawing.
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Accucadd drawings are made up of lists of Entities, as explained in section 2 of this manual, under “Orienta-

tion”. A technical description of the various kinds of Entity is given in Appendix E of this manual, “RDF Files”.

The Entities that can be created with Accucadd are:

Elements: Line Line elements are used by all functions that generate individual
straight lines, including the Dimension and Parallel Lines functions.
They can usually be selected for editing functions at any point along
them; when selected they are marked at their endpoints and mid-
points.

Arc Arc elements are used by all functions that generate arcs, including
the dimensioning and filleting functions. They are selected and
marked for editing like Lines.

Circle Used by all functions that generate circles; selected like a Line and

marked at each point of the compass.

Nib Used by Draw: Elements: Nib; it is not made out of individual Line enti-
ties. ANib can only be selected by its corners; they are marked when it
is selected.

Handle Used only by Draw: Elements: Handle. It is shown as a small triangle
which is selected and marked by its center.

Records: Hatch Used only by Draw: Hatch; it is selected for editing by its Seed Point
and marked as selected there.

Text Used for all text in the drawing, including that created by Dimension
functions and Arrowheads. A Text Record has a handle at the position
used to position it in the drawing; it is selected there and marked as se-
lected by having a box drawn round it.

Insert Used by Drag Insert, Frame Insert and Fit Insert. An Insert has one or
more Handles, created by Handle elements in the drawing that has
been Inserted. It can be selected by any one of its handles and is
marked by having a box drawn round it.

Curve Used by Draw: Curve to create its special curves. It can be selected at
any point along its length, and is marked by having a box drawn
around it.

Dimension This very large record holds all the information needed to create a Dis-
tance, Angle, Radius or Diameter Dimension. It can be selected by the
endpoints of the line or arc it describes, the center of the arc, or the
handle of the dimension text. It is marked at its text handle.

Stream Aseries of points, joined by short lines. Stream records can only be se-
lected by their endpoints and are marked by having a box drawn
around them. Accucadd does not generate Stream records, but sup-
ports those found in drawings from earlier systems.
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